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Kullaruz: Adi:

Sifre:

deneme

Giris Yap

o) Form?2

Tebrikler, Baganh Girig Yaptiruz

CIKIS

o' Form1
Kullarucy Adi:
Sifre:
Ging Yap
o' Form1
Kullares Adi: |yanliskullanici
Sifre:
Ging Yap

Kullania adinizi ve sifrenizi kontrol ediniz. Kalan haklkniz: 2

-




islem Gecmisi islem Sec

: islem S
R I:l slom see @® Sonucu Yazdir ® Topla
sz [ ] O Yazdima O oo

O Garp
Sonug: [ ]

O Bal

islem Yap Cikis

Temizle

private void button2_Click(object sender, EventArgs e)

{//CIKIS
//Application.Exit();

DialogResult sonuc;
sonuc = MessageBox.Show("GCikmak istediginize emin misiniz?","Dikkat",MessageBoxButtons.OKCancel,MessageBoxIcon.Warning );
if (sonuc == DialogResult.OK)
{
Application.Exit();//Uygulamadan tamamen ¢ikar
//Forml.ActiveForm.Close();//Aktif formu kapat




private void buttonl_Click(object sender, EventArgs e)
{//islem Yap

double sayil = -1;
double sayi2 = -1;
if (textBoxl.Text != "")
{

sayil = Convert.ToDouble(textBoxl.Text);
¥
if (textBox2.Text != "")
{

sayi2 = Convert.ToDouble(textBox2.Text);
}
double sonuc = -1;

islem = "";

/*
if (radioButtonl.Checked == true)//topla
{

sonuc = sayil + sayi2;

islem = "+";

>

¥
else if (radioButton2.Checked == true)//¢ikar
{

w_m

sonuc = sayil - sayi2;
islem = K

3
else if (radioButton3.Checked == true)//carp

{
sonuc = sayil * sayi2;
islem = "x";

}

else if (radioButton4.Checked == true)//bdl

{
sonuc
islem

¥/

sayil/sayi2;
nyes

if (comboBoxl.Text == "Topla")
{

sonuc = sayil + sayi2;

islem = "+";
} else if (comboBoxl.Text == "Cikar")
{

sonuc = sayil - sayi2;

islem = "-";
¥

else if (comboBoxl.Text == "Carp")
{

sonuc = sayil * sayi2;

islem = "#*";
¥

else if (comboBoxl.Text == "B&1l")

{

sonuc = sayil / sayi2;
islem = "/";
¥
else if (comboBoxl.Text == "Karekok Al")
{
sonuc = Math.Sqrt(sayil);
islem = "Karekdk";
}
else if (comboBoxl.Text == "Kuvvetini Al")
{
sohuc = Math.Pow(sayil,sayi2);
islem = "~";
}

//sonuc = Math.Round(scnuc,4);




//islem gecmisi
if (radioButton5.Checked)

{
if (comboBoxl.Text == "Karekok Al")
{
richTextBox1.AppendText("Karekok("+sayil.ToString()+")=" + sonuc + Environment.NewLine);
¥
else
{
richTextBox1l.AppendText(sayil.ToString() + islem + sayi2.ToString() + "=" + sonuc + Environment.NewLine);
¥
}

private void button3_Click(object sender, EventArgs e)

{

richTextBoxl.Clear();

//richTextBox1l.Text = "";
}
private void Forml_Load(object sender, EventArgs e)
{

comboBox1.SelectedIndex = 8;
}
private void comboBox1l_SelectedIndexChanged(object sender, EventArgs e)
{

if (comboBoxl.Text == "Karekdk Al")

{

textBox2.Text = "";

//textBox2.Clear();
textBox2.ReadOnly = true;




5! Alan-Hacim Hesapla

Ilem Seginiz
(® Alan Hesapla
(O Hacim Hesapla

Sekil Seginiz
(® Daire

O Dikdartgen

Yancap: (cm): 4

HESAPLA

Alan (em2):

Alan-Hacim
Hesaplama Ornegi

50.265482457

o' Alan-Hacim Hesapla

Ilem Seginiz
(O Alan Hesapla
(® Hacim Hesapla

Jekil Seginiz

O Kip




a5 Mot Hesaplama Araci — O b4 a5 Not Hesaplama Araci — O
Not Girgi Hesaplama Not Girigi Hesaplama
Min Gegme Notu: Min Gegme Notu: E’
Vize Katki Orani (%): | | Howwa Vize Katks Orar (%): e
Final Katha Oraru (%): | | ona Final Katha Oraru (%): ona .
ama: ama:
Vize Notu: Vize Notu:
s [ s [0
MNot Hesaplama Arac - Cl pd Mot Hesaplama Araci - Cl
a a
Not Girigi Hesaplama Not Girigi Hesaplama
Min Gegme Notu: Min Gegme Notu:
Vize Kaths Oran (%) 40 | i Vize Katki Oran (%): [50 | Hesapla
Final Kathi Oranu (%): 60 ora Final Katki Oraru (%): |60 |
ama: 56
Vize Notu: Vize Notu: 75
Final Notu: Final Notu: E Vize ve Final katk oranlan toplami 100 olmalidr!
I Tamam
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Ogr. No: |2011710404000 |
Ad-Soyad: |Cemal Kaplan |
Sin: |2 v‘

[] Listeye Bkle

[ ] Listeye Ekle a2 Form1 _ O %

Manuel Sinif Ekleme

| | Ekle

2011810404000

.| Kemal Arslan

5%?

[/] Listeye Ekle

Manuel Sinf Ekleme
Hazirik Ekle




private void buttonl Click(object sender, EventArgs e)

{
panell.Visible = true;
textBoxd.Text = textBoxl.Text;
textBox3.Text = textBox2.Text;
textBox5.Text = comboBox1.Text;
}

private void checkBox1l CheckedChanged(object sender, EventArgs e)

{
if (checkBox1.Checked == true) {
groupBox1.Visible = true;
1 else
{
groupBox1.Visible = false;
h
h

private void button3 Click(object sender, EventArgs e)

{
comboBox1.Items.Add(textBox6.Text);

¥




Pizza Siparis - ODEV

o' Form3

Boyut Seginiz

() Kigik (11 TL
O Orta (16 TL)
(O Biyik (30 TL)

Hesapla

Tur Segniz
(O Bol Sucuklu

(O Margarita
(O Sebazeli (+#2 TL)

Fiyat:

Ekstralar

(O Bol Kekik (+2 TL)
() Ekstra Sos (+3TL)
(O Masr(+2 TL)




YENi FORM -Uygulama

o) Girig Paneli = B [

Kullanicr Ad: | ‘
Sifre: | |
Giris Yap
Forml

-/ Malzeme Takip Programi

Dosya  Yeni Malzeme  Cikig

Yeni Malzeme

Kaydr Malzeme Giris

Stok Sayim Tedarikci Kayit

o2 Yeni Malzeme

Kaydedilen Bilgiler
Malzeme Kodu: | ‘ Y J

Malzeme Kodu:
Malzeme Adr: | ‘

Malzeme Adi:
Birim: ~

Birim:
Birim Fiyat: | |

Birim Fiyat:
Tedarikgi: | |

Tedarikei:

Kayit Onayi

KAYDET

label11

label12

label13

label14

label15

=)

Form3

[ ol

Malzeme Cikis

Raporlama

Form?2

L




public partial class Forml : Form

{
public Forml1()
{
InitializeComponent();
}

kullaniciAdi = "admin”;
string sifre = "9876";
int sayac = @;

private void buttonl_Click(object sender, EventArgs e)

{
if (textBox1l.Text == kullaniciAdi && textBox2.Text == sifre)
{
Form2 frm2 = new Form2();
frm2.Show();
this.Hide();
¥
else
{
sayac++;
MessageBox.Show("Kullanici adiniz ve/veya sifreniz yanlistir. Kalan deneme hakkiniz: " + (3-sayac), "Hatal",
MessageBoxButtons.0K, MessageBoxIcon.Error);
if (sayac == 3)
{
MessageBox.Show("Baska deneme hakkiniz kalmadi. Program sonlandiriliyor.");
Application.Exit();
h
}
h




public partial class Form2 : Form

{
public Form2()
{
InitializeComponent();
h
private void ¢ikisToolStripMenuItem Click(object sender, EventArgs e)
{
Application.Exit();
¥
private void Form2 FormClosing(object sender, FormClosingEventArgs e)
{
Application.Exit();
h
private void yeniMalzemeToolStripMenuItem Click(object sender, EventArgs e)
{
buttonl.PerformClick();
h
private void buttonl Click(object sender, EventArgs e)
{
Form3 frm3 = new Form3();
frm3.Show();
//this.Hide();
h




public partial class Form3 : Form

{

public Form3()
{

h

InitializeComponent();

private void buttonl Click{object sender, EventArgs e)
{

malzemeKodu = textBoxl.Text;

malzemeAdi = textBox2.Text;

birim = comboBoxl.Text;

birimFiyat = textBox3.Text;

tedarikci = textBox4d.Text;

labelll.Text = malzemeKodu;
labell2.Text = malzemeAdi;
labell3.Text = birim;

labell4.Text = birimFiyat;
labell5.Text = tedarikci;

groupBox1.Visible = true;

if (checkBox1.Checked)
{

MessageBox.Show("Yeni malzeme bilgisi basarila
"bir sekilde kayit edilmistir."™);

private void textBoxl TextChanged(object sender, EventArgs e)

{
if (System.Text.RegularExpressions.Regex.IsMatch(textBox1.Text,

{

MessageBox.Show("Liitfen sadece rakam giriniz");
textBoxl.Text = textBoxl.Text.Remove(textBoxl.Text.Length -

}

private void textBox3 TextChanged(object sender, EventArgs e)

{
if (System.Text.RegularExpressions.Regex.IsMatch(textBox3.Text,

{

MessageBox.Show("Liitfen sadece rakam giriniz");
textBox3.Text = "";
//textBox3.Text = textBox3.Text.Remove(textBox3.Text.Length

}

private void textBox2 TextChanged(object sender, EventArgs e)

{
if (System.Text.RegularExpressions.Regex.IsMatch(textBox2.Text,

{

MessageBox.Show("Liitfen sadece harf giriniz");
textBox2.Text = "";

"[%0-91"))

1);

"[%0-9.1"))

- 1);

“[~A-20-91"))




CS3-2 — Sepete Ekle

= Bu projede Combobox ve ListBox kullanimina yonelik bir calisma capilacaktir. ListBox1’den segilen
uranu, ComboBox'tan secilen adet ile birlikte ListBox2'ye ekleyecegiz. Bunu yaparken, butona her
tiklandiginda, Urtnlerin birim fiyat ve secilen adet bilgisi kullanilarak Toplam Fiyat bilgisi de

guncellenecektir. Birim fiyatlar asagida verilmigtir.

= Ceket: 200 PB, Gomlek: 80 PB, Kazak: 100 PB, Pantolon: 120 PB.

o= Form1

Uriin Secginiz:

Ceket
Gomlek
Kazak
Pantolon

Birm Fiyat: 00

E=n e X"

Adet Seciniz: Sepetteki Urtnler:
listBox2
Sepete Ekle
Toplam Fiyat: 00

8y Form1

Urin Seginiz: Adet Segniz:

Ceket - 1
Gomlek
Kazak

Sepete Bkle

Bim Fiyat: 120

— [ ps

Sepetteki Urunler:

Gomlek : 2 adet
Pantolon: 1 adet

Toplam Fiyat: 280




private void listBox1l SelectedIndexChanged(object sender, EventArgs e)
{
if (listBoxl.Text == "Ceket")
{
label5.Text = "200";
} else if (listBoxl.Text == "Gomlek™)
{ int toplam = @;
labelS.Text = "80": private void buttonl Click(object sender, EventArgs e)
* »
} else if (listBoxl.Text == "Kazak") ! _ _
{ listBox2.Items.Add(listBox1.Text + ": " + comboBox1l.Text + " adet™);
label5.Text = "100"; int birimfiyat = @;
} else if (listBox1.Text == "Pantolon™) ?F (ListBoxl.Text == "Ceket")
{ label5.Text = "120"; birimflyat = 200;
- - ;] }
) else if (listBox1l.Text == "Gomlek™)
J {
birimfiyat = 80;
}
else if (listBox1l.Text == "Kazak")
{
birimfiyat = 100;
}
else if (listBoxl.Text == "Pantolon™)
{
birimfiyat = 120;
}

int adet = Convert.ToInt32(comboBox1.Text);
toplam = toplam + birimfiyat * adet;
label6.Text = Convert.ToString(toplam);




Radyo Programi

= Windows’un kendi muzik calari olan Windows
wmv, avi gibi dosyalari yurutebileceginiz basit

= Windows’un kendi muzik c¢alari olan Windows
Media Player’| C# igerisinde kullanarak mp3,
wav, wmv, avi gibi dosyalari yurutebileceginiz
basit bir muzik calar yapalim.

= Toolbox’ta standart olarak Windows Media
Player 6gesi gelmedigi icin bunun sonradan
eklenmesi gerekir. Toolbox Uzerinde bos bir
alanda mouse sag tik yaparak “Choose
ltems” segenegine tiklayin.

Media Player’t C# igerisinde kullanarak mp3, wav,

bir mUzik ¢alar yapalim.

ﬂ File Edit View Project Build Debug Format Test Analyze Tools

SR

-

~ | Debug ~ AnyCPU

Toolbox * 0 X Forml.cs [Design] ® X

Search Toolbox

Extensions  Window  Help Search (Ctrl+Q

> All Windows Forms
I Common Controls

Sa21N0S5 e1eq W

> Containers
> Menus & Toolbars
l> Components

I> Printing
I> Dialogs
> Data
> WPF Interoperability
I> General

Paste

List View

Show All

Choose Items...

Sort ltems Alphabetically
Reset Toolbox

Add Tab

Delete Tab

Rename Tab

Move Up

Move Down



b<) File Edit  View
0~

Toolbox

Search Toolbox

l> All Windows Forms
I> Common Controls

I> Containers

I> Menus & Toolbars

> Components

I> Printing

I Dialogs

> Data

I WPF Interoperability
I> General

Bro W

- | Debug - AnyCPU

Debug Test Analyze Tools

Form1.cs [Design] + X

Extensions

Window  Help

- P Stat~| g i

Search (Ctrl+Q)

= Ardindan acilan pencerede Com Components sekmesine gelip Windows Media Player’i secin ve
ardindan Tamam deyin.

pe CS-3Rad

Language: Language Meutral

Version: 1.0

Choose Toolbox Items ? X
NET Framework Components | COM Components | Universal Windows Components | WPF Components
Name Path Library Last Modifi ™
O SysColorCtrl class CAWINDOWS\system32\cic.dll cic 1.0 Type Libra.. 19/03/2019
O System Monitor Control CAWINDOWS\System32\sysmon.ocx System Monitor.. 19/03/2019
] Tabular Data Control CAWindows'SysWOWe4\tdc.ocx 19/03/2019
O TaskSymbol Class CAWINDOWS\system32\mmendmar....  MNodeMgr 1.0 Ty..  19/03/2019
[] VideoRenderCtl Class CAWindows'\SysWOWe4\qdvd.dll 19/03/2019
[JvsTO FormRegionsHostX c\Program Files (x86)\Commaon Files\... 22/07/2018
[] VSTO WinFormsHost Control c\Program Files (x86)\Common Files\.. Microsoft Visual .. 22/07/2018
[] Windows Mail Mime Editor CAWindows'\SysWOWe4\inetcomm.dll 19/03/2019
Windows Media Player CAWINDOWS\system32\wmp.dll Windows Media .. 13/03/2020
[] Windows Store Remote Desktop Cl... CAWINDOWS\system32\mstscax.dll Microsoft Termin...  14/02/2020
[l WorkspaceBrokerfx Class CAWINDOWS\system32\wkspbroker..  WorkspaceBroke... 19/03/2019
W

L4 >
Adobe Acrobat DC Browser Control Implementation

Browse...

OK H Cancel H Reset




= Simdi Toolbox icerisine Windows Media Player 6Jesi eklendi. = fom EERECE X
Artik formu tasarlarken bu 6geden faydalanabilirsiniz.
Formumuzu yandaki gibi tasarlayabiliriz:

= Butonlarin igerisine link ekleyerek tiklandiginda belirli radio
frekanslarinin galmasini saglayacagiz.

= Ornegin buton1’e tiklandi§inda asagidaki linkte bulunan media

oynatilsin:
https://listen.powerapp.com.tr/powerfm/abr/powerfm/128/playlist. m3u8

button button2

= Bunu yapmak icin buton1’in mouse click olayina asagidaki komutu yazmamiz yeterlidir:
axWindowsMediaPlayerl.URL = "https://listen.powerapp.com.tr/powerfm/abr/powerfm/128/playlist. m3u8";

= Benzer sekilde buton2 icin de asagidaki komutu yazalim:
axWindowsMediaPlayerl.URL = "http://fenomen.listenfenomen.com/fenomen/128/icecast.audio”;

= Artik buton1’ basildiginda PowerFM, buton2’ye basildiginda ise RadyoFenomen calacaktir.

= Diger radyolarin ¢calma linkleri Google Uzerinden yapilacak basit bir aragtirma ile bulunabilir. @


https://listen.powerapp.com.tr/powerfm/abr/powerfm/128/playlist.m3u8

= Butonlarin Uzerine de radyolara ait gorseller asagidaki gibi eklenebilir. Bunun i¢in butonun
Backgroundlmage ozelligi kullanilarak Import butonu ile gorsel secilir.

Sl == Select Resource ? X
- Resource context
Properties *OX
- () Local resource:
button1 System.Windows.Forms.Button -
o= T4 |90| %
AllowDrop False - @ Project resource file:
Anchor Top, Left
AutoEllipsis False Properties\Resources.resx
AutoSize False (none)
AutoSizeMode GrowOnly
g _ BackColor I:l Control
- ; Backgroundimage |:| (none)
d button 2 button2 Backgroundlmagelayout  Tile
& O o CausesValidation True
ContextMenuStrip (none)
Cursor Default
DialogResult None mport..
Dock None
Enabled True - oK Cancel




= Her iki butonumuz i¢in de gorseller secildikten sonra bu gorsellerin buton tGzerinde dogru

yerlesiminin saglanmasi icin BackgroundimageLayout ozelliginden Stretch secilir.

button2

= | B || &3

Properties

o= T4 9 %
Anchor
AutoEllipsis
AutoSize
AutoSizeMode
BackColor

Backgroundlmage

Backgroundlmagelayout
CausesValidation
ContextMenuStrip

Cursor

DialogResult

Dock
Enabled
FlatAppearance

button1 System.Windows.Forms.Button

Top, Left
False
False
GrowOnly

|:| Control

Stretch

v M X

Fiiz| €5_3.Properties.Resource

e

MNone

= || [ | &I

Properties

o= 4|00 %
Anchor
AutoEllipsis
AutoSize
AutoSizeMode
BackColor

Backgroundimage

CausesValidation
ContextMenuStrip
Cursor
DialogResult

Dock
Enabled
FlatAppearance

button2 System.Windows.Forms.Button

Backgroundimagelayout

Top, Left

False

False

GrowOnly

I:l Control

E C5_3.Properties.Resource
Stretch i




= Artik programimizi ¢alistirdigimizda butonlara tiklayinca radio kanallarimiz ¢alisir durumdadir. Daha
fazla kanal ekleyerek tasarim uzerinde degisiklikler yapilarak asagidaki gibi daha fazla kanaldan
olusan bir form elde edilebilir: ks s RS A . o

) Ibrahim Kucukkoc - Radyo Uygulamasi 2019 | - H = H | - m
A\\.\l LA
N QRIS

I

‘\I)I 4 Pl 4) ==

SHesW '
m @ Ibrahim Kucukkoc - Radyo Uygulamasi 2019 — O
Hlnl". ” | || || || i
3l 11
“ u n‘&;ﬁ) . ,]H ALEM i
F ®/ £

RIRVASTA

SHe'W

advis L d
NS

t[)l 4 bl §) —s



ODEV-1

= Formunuza asagidaki gibi TARA ve TARAMAYI| DURDUR butonlari ekleyiniz.

= TARA butonuna bastiginizda eklemis oldugunuz kanallar arasinda tarama yapilsin, her 8 saniyede
bir yeni kanala gecilsin. Son kanala ulasildiginda ise basa geri donulsun
- Ipucu: Déngii kullanmaniz gerekiyor )

@Ibrahim Kucukkoc - Radyo Uygulamasi 2019 | = || (=] ||ﬂi|

= TARAMAYI| DURDUR butonuna
basildiginda ise o sirada ¢almakta olan
kanalda kalinsin.




CS-4 Stok Hareketleri

o2 Form1 — O e

Yeterli stok bulunmamaktadir

[ o ]




private void Forml Load(object sender, EventArgs e)

{

listViewl.Columns.Add("Stok Kodu", 65);
listViewl.Columns.Add("Islem Turi", 65);
listViewl.Columns.Add("Miktar"”, 45);
listViewl.Columns.Add("Tarih", 75);
labelll.Text = stoksml.ToString();
labell@.Text = stoksm2.ToString();
label9.Text

= stoksm3.ToString();

listViewl.Items.Add(comboBox1.Text);//stok kodu

islem = "";

if (radioButtonl.Checked)
{

1slem = "Alis"™;
h
else if (radioButton2.Checked)
{

islem = "Satis";
¥

listViewl.Items[listViewl.Items.Count - 1].SubItems.Add(islem);//islem
listViewl.Ttems[listViewl.Ttems.Count - 1].SubItems.Add(textBox1.Text);//miktar
listViewl.Ttems[listViewl.Ttems.Count - 1].SubItems.Add(dateTimePickerl.Text);//tarih




if (islem == "Alis™)

{
if (comboBox1l.Text == "SM1")
{
stoksml += Convert.ToInt32(textBoxl.Text);
labelll.Text = stoksml.ToString();
h
else if (comboBoxl.Text == "SM2")
{
stoksm2 += Convert.ToInt32(textBoxl.Text);
labell0.Text = stoksm2.ToString();
¥
else if (comboBoxl.Text == "SM3")
{
stoksm3 += Convert.ToInt32(textBoxl.Text);
label9.Text = stoksm3.ToString();
¥
}
else if (islem == "Satis")
{
if (comboBox1l.Text == "SM1")
{

stoksml -= Convert.ToInt32(textBoxl.Text);

Tahnalll Toawtdr — ctalremd ToaCtmamerd Y

{

yeterli = true;

-if (radioButton2.Checked)

if(comboBoxl.Text == "SM1")

{

if (Convert.ToInt32(textBoxl.
{

MessageBox.Show("Yeterli
yeterli = false;

h
h
if (comboBoxl.Text == "SM2")
{
if (Convert.ToInt32(textBoxl.
{
MessageBox.Show("Yeterli
yeterli = false;
h
h
if (comboBox1l.Text == "SM3")
{

if (Convert.ToInt32(textBoxl.
{

MoccaooBRnv Shrw "Votorli

Text) > stoksml)

stok bulunmamaktadir™);

Text) > stoksm2)

stok bulunmamaktadir");

Text) > stoksm3)

ctnle hulunmamaltadie™y

®




CS-5 Regresyon Analizi (Talep Tahmini)

y=a+bx

=« Bu projede Regresyon Analizi ile talep tahmini yapan bir program ve araylz gelistirilecektir. Onceki
donemlerde gergeklesen satiglara iliskin veri yine araylz vasitasi ile alinacaktir. Bunun icin oncelikle
araylizden dénem sayisi secilecek ve ILERLE butonuna basilacaktir. Ardindan, her bir ddSneme
iliskin satis verisi birer birer TextBox’a girildikten sonra EKLE butonuna basilarak ListBox’a

eklenecektir.

o5 Regresyon (Talep Tahmini)

Veri Girisi
ILERLE

Gergeklesen Satislar

1.Dénem Satisr: | | EKLE

listBox1

SIFIRLA

=8 BOTl ™

Regresyon denklemi

Regresyon Denklemini Bul

a b:
y=a+bx

Toplam Sapma:

Siradaki Donem Tahmini: ...

Tahminleme

Tahmin Yapilacak Ddnem: I:I

Tahmin Yap

Yapilan Tahmin-

g5 Regresyon (Talep Tahmini)

Vi G
Donem Sayis: |Sean -
ILERLE

Gergeklesen Satiglar
1. Donem Satisi: EKLE

SIFIRLA

Reagresyon denklemi

Regresyon Denklemini Bul

l'l

y=a+Dx

Toplam Sapma: ...
Swradaki Donem Tahmini- ...

Tahminleme
Tahmin Yapilacak Donem:

Tahmin Ya
p

Yapilan Tahmin: ...




= Istenen dénem kadar veri girildikten sonra Regresyon Denklemini Bul butonu aktif hale gelecektir.

Bu butona basildiginda “a ve b parametreleri”, “regresyon denklemi”, “toplam sapma” ve “siradaki
donemin talebi” bulunacaktir.

o' Regresyon (Talep Tahmini) — [ .t ! Regresyon (Talep Tahmini) - Ll X
Regresyon denklemi Regresyon denklemi
a b: a 7 b: 26
y=a+bx y=7+26x
Toplam Sapma: .. Toplam Sapma: 2
Swadaki Donem Tahmini: ... Swradaki Donem Tahmini: 20
Tahminl Tahminleme
Tahmin Yapilacak Donem: Tahmin Yapilacak Donem:
Tahmin Yap Tahmin Yap
Yapilan Tahmin: ... Yapilan Tahmin: ...




=Y = a + bX denkleminde a ile b
parametrelerinin  alacagi  degerler
asagidaki formduller kullanilarak ile
bulunur:

o Regresyon (Talep Tahmini)

— 1
Regresyon denklemi
Regresyon Denklemini Bul
a 7 b: 26
y=7+26x
Toplam Sapma: 2

Swradaki Donem Tahmini- 20

Tahmiri

Tahmin Yaplacak Donem:

Tahmin Yap

Yapilan Tahmin: ..




o Regresyon (Talep Tahmini}

- d
Regresyon denklemi
Regresyon Denklemini Bul
a 7 b: 26
y=7+286x
Toplam Sapma: 2

Swadaki Donem Tahmini: 20

Tahminl

Tahmin Yapilacak Donem: |7

Tahmin Yap

Yapilan Tahmin: 252

= Ayrica, elde edilen a ve b parametreleri ve
dolayisiyla regresyon denklemi kullanilarak
herhangi bir donem igin de talep tahmininde
bulunulabilecektir.




public partial class Forml : Form

{

static int n = 10;
int k = 9;
double b;
double a;

public Forml()

private void comboBox1 SelectedIndexChanged(object sender, EventArgs e)

{
InitializeComponent();
)
{
¥
//ILERLE

private void buttonl Click(object sender, EventArgs e)

{

n = Convert.ToInt32(comboBoxl.Text);

comboBox1.Enabled = false;
groupBox2.Enabled = true;
button2.Enabled = false;
textBox1.Select();

//EKLE
private void button2 Click(object sender, EventArgs e)
{
if (k < n)
{
listBox1.Items.Add(textBox1.Text);
k++;
label2.Text = (k+1).ToString() + ". Donemin Satisi:";
textBox1.Clear();
button2.Enabled = false;
textBoxl.Select();
¥
if (k == n)
{
label2.Enabled = false;
button2.Enabled = false;
textBoxl.Enabled = false;
groupBox2.Enabled = true;
groupBox3.Enabled = true;
h
b




//Hesapla
private void button4 Click(object sender, EventArgs e)

{ //sapmay1 hesapla
double[] Y = new double[n]; double[] tahmin = new double[n];
double[] X = new double[n];
double vy;

EUP (int 1 = @; i < n; i++) for (int i = @; i < n; i++)

V[%] = Fonvert.ToDouble(listBoxl,Items[i]}; { y=a+b*(i+1);

X[1] =1+ 15 tahmin[i] = y;
) }

double XToplam = @;
double YToplam = @;
double XKareToplam = @;

double sapma = @;
for (int 1 = 8; 1 < n; i++)

double XYToplam = @; {
sapma += Math.Abs(Y[i] - tahmin[i]);
for (int i = @; i < n; i++) ¥
I labelll.Text = Math.Round(sapma, 4).ToString();
XToplam += X[i]; labell3.Text = Math.Round(a+b*(n+1), 4).ToString();
YToplam += Y[i]; groupBox4.Enabled = true;
XKareToplam += X[1] * X[1]; 1
XYToplam += X[1] * Y[1];
h
b = (n * XYToplam - (XToplam * YToplam)) / (n * XKareToplam - XToplam * XToplam);
= (YToplam - b * XToplam) / n;
label6.Text = Math.Round(a, 4).ToString();

label7.Text = Math.Round(b, 4).ToString();
label3.Text = "y = " + Math.Round(a, 4).ToString() + " + " + Math.Round(b, 4).ToString() + " x";




//TAHMIN YAP
private void button5 Click(object sender, EventArgs e)

{
int x = Convert.ToInt32(textBox2.Text);

double vy = a + b * x;
labell10.Text = Math.Round(y, 2).ToString();

}

private void textBox2 TextChanged(object sender, EventArgs e)
{

if (textBox2.Text I= "")
{

button5.Enabled = true;
}
else
{

button5.Enabled = false;
}

//SIFIRLA

private void button3_Click(object sender, EventArgs e)

{

comboBox1.Enabled = true;
comboBox1.Text = "1";
label2.Enabled = true;

label2.Text = "1. Donemin Satisi:";
button2.Enabled = false;
textBoxl.Enabled = true;
listBox1.Items.Clear();

k = @;

n = Convert.ToInt32(comboBoxl.Text);
groupBox2.Enabled = false;
groupBox3.Enabled = false;
groupBox4.Enabled = false;




Veritaban Kullanimi - Ogrenci Kayit Projesi

= Bu proje icin oncelikle MS SQL Server Management Studio bilgisayara kurulmalidir. Nasil
kurulacagina iliskin buradan yardim alabilirsiniz: https://www.youtube.com/watch?v=HRe|BIOKZp0

oF Connect to Server X
Microsoft
' SQL Server
SQL Server Management Studio
Server type: | Database Engine w |
Server name: LEr"-.l'CZI‘-,-'-C]- (UCUKKO V|
Authentication: ‘Windows Authentication v
User name: LENOVO-IKUCUKKC\ibrah w
Password:

Remember password

Connect | | Cancel ‘ | Help ‘ ‘ Options >>



https://www.youtube.com/watch?v=HRejBl0KZp0

= Yardim Videosu: https://www.youtube.com/watch?v=9ai0Rc-4LKY

= Database -> New Database yolu izlenerek sadece Database Name kismina isim verildikten sonra

’
OK’e tiklantr.
B New Database - O X
L-},; Microsoft SQL Server Management Studio el a page LT Script ~ @ Help
& General
File Edit View Project Tools Mindow  Help & Options ,
" o , P < & Filegroups Database name: |Ogren::|
- q_:‘]" - - HH ‘ a=1 New Query e% .ﬁ? DME XMLA DAX ‘ or- |<defau|t> |
‘ Execute ‘
Object Explorer >~ I
e * }c; G o Database files:
Logical Mame  File Type  Filegroup Initial Size (MB) Autogrowth [ Maxsize Path
L LENWOVO"KUCUKKO (5QL Server 14.0. Ogrenci ROWS .. PRIMARY 8 | By 64 MB, Unlimited || C:\Prog
= New Database... Ogrenci_log LOG Mot Applicable 8 By 64 MB, Unlimited .| C:\Prog
S
O Attach...
wC Restore Database...
ws Restore Files and Filegroups...
SeCU Filter
Seny :
Rep Deploy Data-tier Application... Connection
Poly Import Data-tier Application... Server:
LENOWVO-IKUCUKKO
Alw, Start PowerShell
Man Report Connection:
Inte eports LENOVO-IKUCUKKOibrah
= SaL Refresh 9* View connection properties
5] XEvent Profiler
Progress
Ready < >

Add Remove


https://www.youtube.com/watch?v=9ai0Rc-4LKY

= Sonra, olusturulan veritabaninin igcinde Tables’in Uzerine sag tiklanarak New -> Table tiklanir.
Olusturulan tabloda kolon isimlerine OgrNo, AdSoyad ve Sehir yazilir. Bu asamada tablo hala
kaydedilmemistir.

|_5; Microsoft SQL Server Management Studio
File Edit View Project Tools Window Help
alk\j‘ e -2 Hu | @ New Query J% uﬁ n@ ;'::i:.‘u DAL | |:'|—J | -

-

| | Execute | |

vqlx

Object Explorer

Connect~ ¥ ¥ ¢ Object Explorer LENOVS IKUCUKKO....nci - dbo.Table_1* & X

= B LENOVO-IKUCUKKO (SQL Server 14.0.10( Connect~ ¥ ¥ Y & - Column Name Data Type
N Dagt;f;:[)atabases =) @ LENOVO-IKUCUKKO (SQL Server 140.10(f Q9o nchar(10)
Database Snapshots = = Databases AdsSoyad nchar(10)
= W Ogrenci System Databases » | Sehir
Database Diagrams Database Snapshots
= FNE‘W » Table = @ Ogrenci
' — Database Diagrams
Filter » Memory Optimized Table... o Tables
Start PowerShell (Tsemporal Table » System Tables
{  Reports ) raph Table > FileTables
E— E_)cternal Table... — - v
External Resources fllelltics
Synonyms

Programmability
Service Broker
Storage

Security

HEEHBEBEBB

L




= Kaydetmek icin Kaydet butonuna tiklanir, tabloya isim verilir.

i

D By AR S RB KA -C -85
|

Save Table 1 (Ctrl+S) [ | | |
LENOVO-IKUCUKKO....nci - dbo.Table_1¥ + X

¢ Column Name Data Type ._-5; LENOVO-IKUCUKKO.Ogrenci - dbo.Table_1* - Microsoft SQL Server Management Studio
'SQL Server 14.0.10( OgrNo nchar(10) File Edit View \Project Table Designer Tools Window  Help
AdSoyad nchar(10) - ?‘3 - -2 [~ ] Hu | @ New Query J% uﬁ nﬁl xﬁ}. nﬁ] | ab |:'|—-I [ﬁ ‘ - - ‘ @ | 2
ses » | Sehir . nchar(10) % | b Execute | | | |
shots
Object Explorer LENOVO-IKUCUKKO....nci - dbo.Table_1* + X
agrams Connect~ ¥ ¥ ¢ Column Name Data Type
bles =) @ LENOVO-IKUCUKKQ (SQL Server 140.10(f  ©9o nchar(10)
: = ¥ Databases AdSoyad nchar(10)
System Databases b Sehir . nchar(10)
Database Snapfhots
= @ Od Choose Name ? X
= Ent for the table:
nter a na or the table:
ogrencibilgileri
OK Cancel




Object Explorer
Connect~ ¥ Y &

W' @ | ENOVO-IKUCUKKO.O....ogrencibilgileri

Column Name

= @ LENOVO-IKUCUKKO (SQL Server 14.0.10¢ OgrNo
= == Databases AdSoyad
System Databases b Sehir
Database Snapshots
= @ Ogrenci
Database Diagrams
= = Tables
System Tables
FileTables
External Tables
Graph Tables
=} dbo.ogrencibil s
Views MNew Table...
External Resource Design
Synonyms Select Top 1000 Rows
Programmability | Edit Top 200 Rows
Service Broker Script Table as »
Storage View Dependencies
Security Memory Optimization Advisor
Security
Server Objects Encrypt Columns...

a4 X
Data Type Allow Nulls Tabloya veri eklemek icin asagidaki
nchar(12) ] . .
nchar(32) ] YOI 1zlenir.
nchar(20) L]
O

I_-;; LENOVO-IKUCUKKO.Ogrenci - dbo.ogrencibilgileri - Microsoft SQL Server Management Studio

File Edit View Project Query Designer Tools Window  Help
e' ielelj‘.' - HH‘J%NEWQUEW@HﬁBﬁ:ﬁ}u@‘%ﬂ—J | - '|@‘D
: | | b Execute ‘ | ‘
Object Explorer LENOVO-IKUCUKKO.O....ogrencibilgileri + > QRI[oloNI Va4
Connect~ ¥ ¢ » OgrNo AdSoyad Sehir
5 @ LENOVO-IKUCUKKO (SQL Server 14.0.10( 201510404034 | Kemal Aslan - | Bursa
= ¥ Databases 201810404025 Resat Nuri . Eskisehir
System Databases 201910404099 Halit Ziya Kenan . Antalya
Database Snapshots 202020404098 Ceren Deren . Malatya
= @ Ogrenci _ 201720404076 Ozge Ozdener Rize
Database Diagrams
o # Tables CE N U | NULL NULL

System Tables
FileTables

External Tables
Graph Tables

B dbo.ogrencibilgileri




|.‘5\: LENOVO-IKUCUKKO.Ogrenci - dbo.ogrencibilgileri - Microsoft SQL Server Management Studio

Filer Edit View Project Table Designer Tools Window  Help Ta.blo Siltunlarlna d.O].’lel‘ek Yeniden
0-o B U LB Brewaey BRIRAR X T|2-C (B3 diizenleme yapmak, 6rnegin stitiin
| [ s | | - eklemekicin tablo isminin iizerine
Object Explorer M B | ENOVO-IKUCUKKO.O...ogrencibilgileri # X sag t11<1anara1< Design’ a t11<1an11'.
Connect~ ¥ ¥ ¢ M Column Name Data Type Allow Nulls
= 8 LENOVO-IKUCUKKO (SQL Server 140100 * | O9rNo | nchar(12) O
= = Databases AdSoyad nchar(32) ]
System Databases Sehir nchar(20) ]
Database Snapshots ]
= @ Ogrenci
Database Diagrams
= © Tables

System Tables
FileTables
External Tables
Graph Tables

- bo.ogrenaanac

New Table...

Views :

External Res| Design

Synonyms Select Top 1000 Rows
Programmat Edit Top 200 Rows

Service Brok Script Table as b
Storage View Dependencies

Security Memaory Optimization Advisor




= Veritabanina veri kaydetmek ve veritabanindaki kayitlari gostermek icin asagidaki gibi bir arayuz
hazirlanmalidir. KAYDET butonu veritabanina veri kaydetmek, GOSTER butonu ise veritabanindaki
kayitlari ListView’da gorunttlemek igin kullantlir.

s Veri Kaydi | = ” = ”i&|

Ogrenci Kaydi Ogrenci No Ad Soyad Sehir

Ogrenci No | |

Ad-Soyad | |

Sehir | |

KAYDET

GOSTER




Veritabanindaki Kayitlarin Gosterilmesi

g Veri Kayd
Odrenci Kaydi
Ogrenci No
Ad-Soyad

Sehir

KAYDET

Ogrenci No

1201510404034

201810404025
201310404093
202020404098
201720404076

GOSTER

Ad Soyad
Kemal Aslan
Regat Nur
Halit Ziya Kenan
Ceren Deren
Ozge Ozdener

Sehir

Eskigehir
Antalya
Malatya
Rize




LUSing System.Data.5qlClient; //SQL icin gerekli kituphane

=namespace VeritabaniDersi

{
= public partial class Forml : Form
{
= public Forml()
{
InitializeComponent();
¥
I SqlConnection baglan = new SglConnection("Data Source=LENOVO-IKUCUKKO;Initial Catalog=0Ogrenci;Integrated Security=True"});
= private void buttonl_Click(object sender, EventArgs e)
{
listViewl.Items.Clear();
baglan.Open();
SqlCommand komut = new SqlCommand("Select * from ogrencibilgileri™, baglan);
SglDataReader oku = komut.ExecuteReader();
= while (oku.Read())
{
listViewl.Items.Add(oku["OgrNo™].ToString());
listViewl.Items[listViewl.Items.Count-1].5ubItems.Add(oku["AdSoyad”].ToString());
listViewl.Items[listViewl.Items.Count-1].SubItems.Add(cku["Sehir”].ToString());
I ¥
baglan.Close();
¥




Veritabanina Kayit Ekleme

s Veri Kayd —
Ogrenci Kayd: OgrenciNo Ad Soyad Sehir
S 1 1201510404034 | Kemal Aslan Bursa
renci No | 201820404078 201810404025 Resat Nuri Eskigehir
201910404099 Haltt Ziya Kenan Antalya
Ad-Soyad  |Simge Deniz 202020404098 Ceren Deren Malatya
201720404076 Ozge Ozdener Rize
Sehir Balikesir 201820404078 Simge Deniz Balikesir
KAYDET
€
GOSTER

private void button3_Click(object sender, EventArgs e)

1

baglan.Openi);

5qlCommand komut2 = new SqlCommand("Insert into ogrencibilgileri(OgrMo, AdSoyad, Sehir) values (" + textBoxl.Text+"', '"+textBox2.Text+"','"+textBox6.Text+"')}", baglan);
komut2 . ExecuteNonQuery () ;

baglan.Close();

buttonl.PerformClick();



Veritabani Kullanimi - Malzeme Kayit Projesi

= Stok hareketlerini kaydetmek, mevcut stok miktarlarini goranttlemek, veritabaninda silme ve
dlzeltme yapmak amaciyla verilen ornek icin asagidaki gibi bir form tasarlanir.

a2 Stok Kayit =N Oy X"

Stok Kodu | Stok Kodu  Stok Ad Mevcut Stok Birim Min Stok  Max Stok

Stok Adi |

Mevcut Stok |

Min Stok |

Birim | v|

Max Stok |

Goruntile Kaydet Sil Duazelt

= Bu projede oncekinden farkli olarak silme ve dizeltme islemleri de yapilacaktir.

= Yardim Videosu: https://www.youtube.com/watch?v=45tftN91eQ0&t=2581s



https://www.youtube.com/watch?v=45tftN9IeQ0&t=2581s

Bu proje i¢in Stok isminde yeni bir veritabani olusturulmalidir. Bunun i¢in yine Database -> New Database
yolu izlenerek Database Name kismina Stok ismi verildikten sonra OK’e tiklanir.
Olusturulan veritabanina Kayitlar isminde bir tablo olusturulur ve siitunlar: asagidaki gibi isimlendirilir.

I_g; LENOVO-IKUCUKKO.5tok - dbo.Table_1LENOVO-IKUCUKKO.5tok - dbo.Kayitlar - Microsoft SQL Server Management Studio

File Edit View Project Query Designer

Q- " -2 H"'",EINBWQU

Window  Help

Object Explorer » [ | LENOVO-IKUCUKKO.Stok - dbo.Kayitlar II! OVO-IKUCUKKOS...ok - dbo.Kayitlar + X

Connect~ ¥ ¥ (VS Column Name Data Type Allow Nulls
5 @ LENOVO-IKUCUKKO (SQL Server 14.0.1¢ StokKodu nchar(4) N
= © Databases StokAdi nchar(15) ]
System Databases MevcutStok nchar(8) ]
Database Snapshots Birim nchar(10) ]

W Ogrenci .
o @ Stok MinStok nchar(8) ]
Database Diagrams »  MaxStok . nchar(8) [
= Tables ]
System Tables

FileTables
External Table
Graph Tables
= B dbo.Kayitlar




Storage I

. .- . o . ’ Security New Table...
= Kayitlar tablosunun uzerine sag tiklanarak Edit Top 200 Rows’a - 8 Stok Desan
o ey . o - . Database Select Top 1000 R
tiklanip asagidaki gibi stok malzemeleri ve bilgiler eklenir. S elect Top 1000 Rows
Edit Top 200 Rows
S_ysten Script Table as »
FileTa View Dependencies
Extern : - ) ies
p Graph Memory Optimization Advisor
4 LENOVO-IKUCUKKO.5tok - dbo.Kayitlar - Microsoft SQL Server Management Studio Encrypt Columns..
File Edit View Project QueryDesigner Tools Window  Help Views Full-Text index ,
- Q- Eil g -~ & v | B NewQuery 3 9 &0 R & | pA g ‘ - - ‘ 4| | o] External f Storage 1

Synonym
| | Execute | ‘ | | ‘

1]

Object Explorer

Connect~ ¥ S StokKodu StokAdi MevcutStok  Birim MinStok MaxStok
= @ LENOVO-IKUCUKKO (5QL Server 140.10f » I M3 Somun .. 3750 Gram 250 2000
= Databases 1002 Disli 55 Adet 15 100

System Databases 1003 Vida 4500 Gram 500 6000

Database Snapshots 1004 Rulman 42 Adet 10 50
W Ogrenci 1005 Pim 2125 Gram 250 3000
= i Stok
Database Diagrams * NULL NULL NULL NULL NULL NULL
= I Tables
System Tables
FileTables

External Tables
Graph Tables
E dbo.Kayitlar

0 & ®




= Form tasarimi asagidaki gibidir. Butonlarin igerisine yazilacak komutlar da sonraki slaytlarda
verilmigtir.

o Stok Kayit — O X
Stok Kodu | Stok Kodu  Stok Adi Meveut Stok Birm Min Stok Max Stok
Stok Adi 1001 M3 Somun 3750 Gram 250 5000

1002 Digl 55 Adet 15 100
Meveut Stok | 1003 Vida 4500 Gram 500 6000
Birim o 1004 Rulman 42 Adet 10 50
1005 Pim 2125 Gram 250 3000
Min Stok |
Max Stok < >
Gonintiile Kaydet si Diizelt




‘using System.Data.sqlClient;
—namespace StokKayit
{
E] public partial class Forml : Form
{
| sqlConnection baglan = new SqlConnection("Data Source=LENOVO-IKUCUKKO;Initial catalog=Stok; Integrated Security=true”);
= private void buttonl Click(object sender, EventArgs e) //Goruntule Butonu
{
listviewl.Items.Clear();
baglan.0Open();
SglCommand komut = new SqlCommand(“Select * from kayitlar”, baglan);
SqlDataReader oku = komut.ExecuteReader();
= while (oku.Read())
{
listViewl.Items.Add(oku["StokKodu"].ToString());
listViewl.Items[listViewl.Items.Count - 1].SubItems.Add(oku["StokAdi"].ToString());
listViewl.Items[listViewl.Items.Count - 1].SubItems.Add(oku["MevcutStok"].ToString());
listviewl.Items[listViewl.Items.Count - 1].SubItems.Add(oku["Birim"].ToString());
listViewl.Ttems[listViewl.TItems.Count - 1].SubTtems.Add(oku["MinStok"”].ToString());
listViewl.Items[listViewl.Items.Count - 1].SubItems.Add(oku["MaxStok"].ToString());
I }
baglan.Close();
I ¥




o Stok Kayit — O *
Stok Kodu 1006 | Stok Kodu  Stok Adi Meveut Stok Birim Min Stok Max Stok
Stok Ady |L,“ti( - | 1001 M3 Somun 3750 Gram 250 5000
1002 Digii 55 Adet 15 100
Mevaut Stok |20 | 1003 Vida 4500 Gam 500 6000
Birim |Kai v| 1004 Rulman 42 Adet 10 50
1005 Pim 2125 Gram 250 3000
Min Stok |4 |
Max Stok (25 | < >
Garirtide Kaydet si | Diizelt |
ol Stok Kayit — %
Stok Kodu | 1006 Stok Kodu  Stok Adi Meveut Stok Binm Min Stok Max Stok
Stok Adi Lastikk 3mm 1001 M3 Somun 3750 Gram 250 5000
1002 Digli 55 Adet 15 100
Mevaut Stok (20 1003 Vida 4500 Gam 500 5000
Biim Koli g 1004 Rulman 42 Adet 10 50
1005 Pim 2125 Gram 250 3000
Min Stok |4 1006 Lastik 3mm 20 Koli 4 25 h
Max Stok |25 | < 3
Gorintide Kaydet si \ Diizek \




private void button2_ Click({object sender, Eventfrgs e) //Kaydet Butonu

{
baglan.Open();

SqlCommand komut2 = new SgqlCommand(”Insert into Kayitlar (5tokKodu,StokAdi,MevcutStok,Birim,MinStok,MaxStok) ™ +
"walues (""+textBoxl.Text+" , "+ textBox2.Text + "', "+ textBox3.Text + "', "+comboBoxl.Text+"', "+ textBox5.Text + "', "+ textBox6.Text + "')",baglan);
komut2.ExecuteNonQuery(};

baglan.Close();
buttonl.PerformClick();

}

private void Forml Load{cbject sender, Eventhrgs e)

{
buttonl.PerformClick();

}




s Stok Kayit — O >
Stok Kodu | 1005 | Stok Kodu  Stok Ad Meveut Stok Binm Min Stok Max Stok
Stok Adi |F‘ir|1 ‘ 1001 M3 Somun 3750 Gram 250 5000
1002 Digl 55 Adet 15 100
Mevout Stok [2125 || 1003 Vida 4500 Gam 500 6000
Binm |Gmm p \ 1004 Rulman 42 Adet 10 50
Pim 2125 Gram 250 3000
Min Stok 250 | 1006 Lastik 3mm 20 Kol 4 25
Max Stok 3000 | < >
Goriintide Kaydet si \ Diizek \
s Stok Kayit — O x
Stok Kodu ITDﬂﬁ | Stok Kodu  Stok Adi Meveut Stok Birim Min Stok Max Stok
Stok Adi |F'|'rn | 1001 M3 Somun 3750 Gram 250 5000
1002 Digh 55 Adet 15 100
Meveut Stok 2125 | 1003 Vida 4500 Gram 500 6000
Binm |Grar|1 p | 1004 Rulman 42 Adet 10 50
1006 Lastik 3mm 20 Koli 4 25
Min Stok 250 |
Max Stok  |3000 | < >
Gériniide Kaydet si | Diizeh |




int kod = 8;
private void listViewl DoubleClick(object sender, EventArgs e) //listview'dan mouse ile secim yapma

{
kod = Convert.ToInt32(listViewl.SelectedItems[@].SubItems[@].Text);
textBoxl.Text = listViewl.SelectedItems[@].SubItems[@].Text;//stokkodu
textBox2.Text = listViewl.SelectedItems[@].SubItems[1].Text;//stokadi
textBox3.Text = listViewl.SelectedItems[@].SubItems[2].Text;//mevcutstok
comboBox1.Text = listViewl.SelectedItems[@].SubItems[3].Text;//birim
textBox5.Text = listViewl.SelectedItems[@].5ubItems[4].Text;//minstok
textBox6.Text = listViewl.SelectedItems[@].SubItems[5].Text;//maxstok

}

private void button3_Click(object sender, EventArgs e)//5il Butonu
{

baglan.Open();

SglCommand komut3 = new 5SglCommand(”Delete from kayitlar where StokKodu=(" + kod + ")", baglan);
komut3.ExecuteNonQuery();

baglan.Close();

buttonl.PerformClick();




o) Stok Kayit _ x
. = 1003 Stok Kodlu malzeme mouse ile
Stok Kodu 1003 | Stok Kodu  Stok Adi Meveut Stok Binm Min Stok  Max Stok _ N T
Stok Ad [Vida || 100 M3Somn 3750 Gam 250 5000 cift tiklanarak secilir ve bilgilerde
1002 Digh 55 Adet 15 100 o
Mevet Siok 4500 | Vida 4500 Gem 500 5000 gerekli dizeltme yapildiktan sonra
Birim lem v ‘ 1004 Rulman 42 Adet 10 50 .
oD | Lasti 3om 20 o 4 % DUZELT butonuna tiklanir.
Max Stok (6000 | < >
Génintile Kaydet i Diizelt
o) Stok Kayit _ ¥
- Stok Kodu (1003 | Stok Kodu  Stok Adi Meveut Stok Binm Min Stok Max Stok
Stok Adh [\,r.da | 1001 M3 Somun 3750 Gram 250 5000
1002 Digli 55 Adet 15 100
Mevos Sok(560 ) || 1003 Vida Gam 500 6000
Birim ’Gram v | 1004 Rulman 42 Adet 10 50
1006 Lastik 3mm 20 Koli 4 25
Min Stok  [500 |
Max Stok 6000 | < >
Gonlintile Kaydet Si Diizek




private void buttond Click(object sender, EventArgs e) //Dizelt Butonu
{
baglan.Open();
SqlCommand komut4 = new SqlCommand(“Update Kayitlar set StokKodu='" + textBoxl.Text.ToString() + "', StokAdi="" + textBox2.Text.ToString() + "'," +
" MevcutStok="" + textBox3.Text.ToString()+ "', Birim="" + comboBoxl1l.Text.ToString() + "', MinStok="" + TextBox5.Text.ToString{) + "'," +
" MaxStok="" + textBox6.Text.ToString() + "' where StokKodu="" + kod+"'",baglan);
komut4.ExecuteNonQuery();
baglan.Close();
buttonl.PerformClick();




DataGridView

= Kayitlari tablolar halinde gostermek icin tasarlanmis bir kontroldur. Kullanimi basittir ve kolaylikla

kisisellestirilebilir.

5 Malzeme Analiz O
Malzeme Bilgileri
Malzeme Kodu: v Birim Fiyat (TL/Adet): TEMIZLE
Malzeme Adr: Min Stok:
Yillik Satis (Adet): Tedarik Suresi (Gun): EKLE
M Kodu M.Ad Yilik Sahig B Fiyat Min Stok T Suresi

= DataGridView’'da, ayarlanan sayi kadar
kolon gosterilir.

= SUtun isimlerinin ayarlanmasi igin kolon

indisi verildikten sonra .Name
ozelligiasagidaki gibi ayarlanir.

//situn isimlerinin ayarlanmasi
dataGridViewl.

dataGridViewl

dataGridViewl

dataGridViewl

ColumnCount = 6; //kolon sayisi

.Columns[@].
dataGridViewl.
dataGridViewl.

Columns[1].
Columns[2].

.Columns[3].
dataGridViewl.

Columns[4].

.Columns[5].

Name

Name =

Name
Name
Name
Name

"M.Kodu";
"M.Ad1";
"Yillik Satis”;
"B.Fiyat";

"Min Stok";
"T.Suresi”;

€



DataGridView

= SUtun genisliklerini ayarlamak icin .Width o6zelligi degistirilebilir.

//Siutun baslangi¢ genisliklerini ayarla
dataGridViewl.Columns[@].Width = 105;
dataGridViewl.Columns[1].Width = 85;
dataGridViewl.Columns[2].Width = 95;
dataGridViewl.Columns[3].Width = 85;
dataGridViewl.Columns[4].Width = 95;
dataGridViewl.Columns[5].Width = 85;

= Sutun genigliklerinin icerige gore otomatik
olarak ayarlanmasi icin asagidaki kod blogu
kullanilabilir.

//Sutunlari Icerige Gore Otomatik genislet
dataGridViewl.AutoResizeColumns();
dataGridViewl.AutoSizeColumnsMode =

a5 Malzeme Analiz

Malzeme Bilgileri

Malzeme Kodu- ’—V‘
[ ]

Yilik Satis (Adet):

Malzeme Adi:

- O x
Birim Fiyat (TL/Adet): TEMIZLE
Min Stok:
Tedarik Suresi (Gun): EKLE ‘

M.Kodu M. Adi
[ 2 M1003

Yatakh Rulman (Ozel) | 2400 180 30

Min Stok T.Suresi

Yilik Satig B Fiyat

DataGridViewAutoSizeColumnsMode.AllCells;




DataGridView

= Calisma esnasinda da DataGridView’a veri eklenmesi, degisiklik yapilmasi mamkuanddr.

= Bu 0Ozellik devre disi birakilmak istenirse DataGridView'in ReadOnly o6zelligi True yapiimalidir.

o= = E R Properties A X
dataGridView1 System.Windows.Forms.DataGridView =
Malzeme Bilgileri % 8 || £
.. . : GenerateMember True -~
Malzeme Kodu: w Birim Fiyat (TL/Adet): TEMIZLE
I:l GridColor |:| ControlDark
Malzeme Adi- Min Stok: I:l ImeMode NoControl
|:| Location 32,223
Yillik Satis (Adet): :| Tedarik Siiresi (Giin): :| EKLE Lacked False
Margin 3,333
MaximumSize 0,0
! = b MinimumSize 0,0
Modifiers Private
MultiSelect True
ReadOnly True -
C 1 RightToLeft

RowHeadersBorderStyle
RowHeadersDefaultCellStyle
RowHeadersVisible
I 'n 5 RowHeadersWidth 51

RowHeadersWidthSizeMode EnableResizing

RowsDefaultCellStyle DataGridViewCellStyle { } hd

Edit Columns..., Add Column...

ReadOnly
Indicates whether the user can edit the cells of the DataGridView contral.

L




DataGridView

= Ayrica DataGridView aracinin ozelliklerinden, sutun genisliginin basliga gore veya hucre

degerlerine gore otomatik olarak ayarlanmasi da yapilabilir.

o | = | B | £3 ]
Malzeme Bilgileri

Malzeme Kodu: Birim Fiyat (TL/Adet): S TEMIZLE
Malzeme Adr: |:| Min Stok: I:l
Yillik Satis (Adet): S Tedarik Siiresi (Giin): S EKLE

[ Im| Litm]

C il

Ll Ly IJ

Properties * O X
dataGridView1 System.Windows.Forms.DataGridView -
= Se||0| %
(ApplicationSettings) —
(DataBindings)

(Name) dataGridView1

AccessibleDescription
AccessibleName

AccessibleRole Default
AllowDrop False
AllowUserToAddRows False
AllowUserToDeleteRows True
AllowUserToOrderColumns False
AllowUserToResizeCaolumns True
AllowUserToResizeRows True
AlternatingRowsDefaultCellStyle DataGridViewCellStyle { }
Anchor Top, Left
None
AutoSizeRowsMode
RarknronmndCalor ColumnHeader
Edit Columns.., Add Column... |AllCellsExceptHeader
AllCells
DisplayedCellsExceptHeader
AutoSizeColumnsMode DisplayedCells

Determines the auto size mode fig) O
"




DataGridView

= [k satira veri eklemek icin asagidaki komutlar kullanilir. Bu komutlar veriyi comboBox ve

textbox’lardan alarak DataGridView’a ekleyecektir.

dataGridViewl.
dataGridViewl.

dataGridViewl

dataGridViewl

= Burada ilk satira ait index numarasinin “0”

Rows[@].
Rows[@].

.Rows[@].
dataGridViewl.

Rows[@].

.Rows[@].
dataGridViewl.

Rows[@].

Cells[@].
Cells[1].
Cells[2].
Cells[3].
Cells[4].
Cells[5].

olduguna dikkat edilmelidir.

Value
Value
Value
Value
Value
Value

comboBox1.Text;
textBox2.Text;
textBox3.Text;
textBox4.Text;
textBox5.Text;
textBox6.Text;

a5 Malzeme Analiz

Malzeme Bilgileri

= Satir numarasi Rows| ] igerisine yazildiktan Malzeme A |nan(Ozel  Min Stok

sonra sutun numaralari da yine “0.” indeksten
baslamak uzere Cells[ ] parantezleri igerisine

yazilir.

Yilhk Satig (Adet): 2400 Tedarik Suresi (Gun): 3

Malzeme Kodu: M1003 - Birim Fiyat (TL/Adet): 180
30

TEMIZLE

. EKLE

M.Kodu M.Ad Yilkk Satig B.Fiyat

) M1003 Yatakh Rulman ({Ozel) m 180

Min Stok
30

T .Siresi
3




DataGridView

= DataGridView’a baska yollarla da satir eklemesi yapilabilir. Asagida, bir onceki slaytta anlatilana
gore daha kolay ve kullanish bir komut verilmektedir:

dataGridViewl.Rows.Add(comboBox1.Text, textBox2.Text, textBox3.Text,

textBox4.Text, textBox5.Text, textBox6.Text);

= GOoruldugu uzere alinan tum veri tek bir
komut satiri ile DataGridView’a
eklenmistir.

u:' Malzeme Analiz O
Malzeme Bilgileri
Malzeme Kodu:  [M3200 Birim Fiyat (TL/Adet): | 80| TEMIZLE
Malzeme Ad:: ’nyum Profil Min Stok: 60!
Yilik Satis (Adet): 840 Tedarik Suresi (Gun): 3‘ EKLE
M.Kodu M.Adi Yillk Satig B.Fiyat Min Stok T.Suresi
R m i 240 360 25 6
M1004 Sol Ayna 680 260 20 2
M3200 Aluminyum Profil | 840 80 60 3




DataGridView

= Asagidaki komutlar DataGridView’'t tamamen temizler.

« TEMIZLE butonunun i¢ine yazilan bu kod blogu, buton her tiklandiginda DataGridView'da mevcut

buatln veriyi silecektir.

dataGridViewl.Rows.Clear();
dataGridViewl.Refresh();

a5 Malzeme Analiz O
Malzeme Bilgileri
Malzeme Kodu: v Birim Fiyat (TL/Adet): TEMIZLE
Malzeme Ad: Min Stok:
Yilik Satis (Adet): Tedarik Sdresi (Gun): EKLE
M.Kodu M.Ad Yilik Satig B.Fiyat Min Stok T.Siresi




DataGridView

= DataGridView’'da secilen bir satirin Calisma esnasinda silinmesi mumkundur. Bu amacla
kullanilacak kodlar asagidaki gibidir.
private void buttonZ_Click(object sender, EventArgs e)

{
1f (dataGridViewl.SelectedRows.Count > @)
{
dataGridViewl.Rows.RemoveAt(dataGridViewl.SelectedRows[@].Index);
}
else
{
MessageBox.Show("Liiffen silinecek satiri secin.");
}
}

= Bunun icin once DataGridView’'dan bir satir secilmeli ve sonra ilgili butona tiklanmalidir.

= EQer bir satir secilmeden butona tiklanirsa “Lutfen silinecek satiri secin” seklinde bir mesaj
goOsterilecektir.




= Projenin devaminda asagidaki menu elemanlarinda da goruldagu gibi ABC analizinin yapilacagi bir
program tasarlanacaktir.

a5 Malzeme Kayit — 0 b4
Matzeme Kay Giks Pareto Curve for ABC-Products
Malzeme Bilgileri t
Malzeme Kodu: | . Birim Fiyat (TL/Adet): | e
Malzeme Adi: Min Stok: |
Yilhk Satis (Adet): Tedarik Suresi (Gun): S s —5
M.Kodu M.Ad Yilik Satig B.Fiyat Min Stok T.Siresi é
&)
Class A Class B Class C
items items items

v

% of total number of items




DataGridView - Veritabani Baglantisi Islemleri

..‘)'; Microsoft SQL Server Management Studio ..‘:; Microsoft SQL Server Management Studio
File Edit View Prgject Tools Window Help File Edit View Project Tools Window Help
- 8- -~ % u ‘ 3 NewQuery 3 57 &0 & & | ‘ - a - - & u ‘ 3 NewQuery 8 7 &7 &8 & | ‘ -
‘ ‘ Execute | ‘ ‘ ‘ Execute | ‘

Object Explorer v 0 x
Connect~ ¥ *¥ Y ¢

Object Explorer v 0 X

Connect~ ¥ *¥ Y & M

B E LENOVO-IKUCUKKO (SQL Server 14.0.10(
=] Databases

Syster New Database... —|

Datal Attach...

= i@ LENOVO-IKUCUKKQO (SQL Server 14.0.10(
= =7 Databases
System Databases
Database Snapshots

w Ogre Restore Database... W Ogrenci
W Stok Restore Files and Filegroups... W Stok
Security = & ABC

Server O Filter

Replicat Deploy Data-tier Application...

Database Diagrams

H

PolyBase Import Data-tier Application... Views‘ New b—| Table...
Always Start PowerShell Extern Filter » Memory Optimized Table...
Manage Synan
Temporal Table »
Integrat Reports Progr Start PowerShell P
2% SQL Sen| Refresh Servic Reports » SEET LR g
External Table...
XEvent ProTEr Storag S— :
Security File Table...

B
A
)
(]
c
=
=)

= Yeni Veritabani Olusturma = Yeni Veritabanina Tablo Ekleme




DataGridView - Veritabani Baglantisi Islemleri

= Tablo sutunlarinin ayarlanmasi

Object Explorer Il | ENOVO-IKUCUKKO....- dbo.Malzemeler # X
Connect~ ¥ ¢ » Column Name Data Type Allow Nulls
5 @ LENOVO-IKUCUKKO (SQL Server 14.0.10( MalzemeKodu nchar(10) [
= ! Databases MalzemeAdi nchar(20) ]
System Databases YillikSatis nchar(10) O
Database Snapshots BirimFiyat nchar(10) ]
W Ogrenci -
& Stok MinStok nchar(10) ]
= & ABC TSuresi nchar(10) ]
Database Diagrams 3 ]
= © Tables

System Tables
FileTables
External Tables
Graph Tables

izl dbo.Malzemeler

Views




DataGridView - Veritabani Baglantisi Islemleri

= Tabloya ilk verinin eklenmesi

Object Explorer v I x W LENOVO-IKUCUKKO....- dbo.Malzemeler + X _

Connect~ ¥ S MalzemeKodu  MalzemeAdi YillikSatis BirimFiyat MinStok TSuresi
= @ LENOVO-IKUCUKKO (SQL Server 14.0.10( HMO01 Malzeme 10000 60 200 3
= ¥ Databases HMO08 Malzeme 3 25000 40 300 4
System Databases 2 MM450 Malzeme 32 600 1200 30 12

Database Snapshots
@ Ogrenci
W Stok
- W ABC
Database Diagrams
= = Tables
System Tables
FileTables
External Tables
Graph Tables

HEEE

B dbo.Malzd New Table...
Views ;
Design
External Resq
Select Top 1000 Rows
Synonyms -
Programmabl___Edit Top 200 Rows
Service Brokd Script Table as »
Storage View Dependencies
Security Memory Optimization Advisor
Security Encrypt Columns...
Server Objects - -
Replication Full-Text index
PolyBase Storage »
Always On High Ay Stretch ;
Management —
R = Intearation Service Policies 4 l‘




Listele()

SglConnection baglanti = new SqlConnection("Data Source=LENOVQ-IKUCUKKO;Initial Catalog=ABC;Integrated Security=True");

private void listele()

{
baglanti.Open();
SqlDataAdapter da = new SqlDataAdapter("select *FROM Malzemeler", baglanti); Veritabanindaki Kayitlarin
DataTable tablo = new DataTable();
da.Fill(tablo); DataGridView’da Listelenmesi
dataGridViewl.DataSource = tablo; T
#7' Malzeme Kayi I ~
baglanti.Close(); d
} Malzeme Kayit  ABC Analizi  Cikig
Malzeme Bilgileri
private void Forml Load(object sender, EventArgs e) , 7 : EXLE
{ Malzeme Kodu: v \ Birim Fiyat (TL/Adet):
listele(); Malzeme Adr: | Min Stok: Sk
J Yillik Satis (Adet): | Tedarik Suresi (Gun): GUNCELLE
. g MalzemeKodu MalzemeAdi Yillik Satis Birim Fiyat Min Stok TSuresi
= listele () metodu Form1’in Load y COE e oo e = "
olayinda ¢agrilirsa form yuklendigi anda |HM003 Malzeme3 |25000 40 300 4

veritabanindaki kayitlar DataGridView’da - [ 1200 30 12

gosterilecektir.




o' Malzeme Kayit — () X

Veritabanina Ekleme ARSI

Malzeme Bilgileri
EKLE
. _ Malzeme Kodu:  [sT047 | Binim Fiyat (TL/Adet): | 25 | _
EKLE Butonu Komutlart: woAk  [ommo | Mnsee — siL

?rivate void button2_Click_1(object sender, EventArgs e) // EKLE Butonu Yilik St (Adet): | 1000 | Tedarik Siresi Gin):[ 5 | ST
tl = comboBox1.Text: ——— - =& s ~ow= e =
zemeKodu alzeme Yillik Satis iim Fiyat inStok uresi
t2 = textBox2.Text; | HMOO1 Malzeme 1 10000 80 200 3
t3 = textBox3.Text; HMO008 Malzeme 3 25000 40 300 4
t4 = textBox4.Text; MM450 Malzeme 32 600 1200 30 12
t5 = textBox5.Text; MM450 MM450 MM450 MM450 MM4S0 | MMA450
t6 = textBox6.Text; > ST047 Celik XXX 14000 2 500 9

baglanti.Open();

SqlCommand komut = new SqlCommand("INSERT INTO Malzemeler (MalzemeKodu, MalzemeAdi, YillikSatis, BirimFiyat, MinStok, TSuresi) " +
IIVALUES (III4_t]-+IIIJIll+t24_lll-'Ill+t3_FT'flJIll+t4+ll'l'-l'lll+t5+ll'lJffl*_t5+lll)'l"fJ baglanti);

komut.ExecuteNonQuery();

baglanti.Close();

listele();
¥

= ComboBox ve TextBox’lara girilen veriler EKLE butonuna tiklanarak veritabanina kayit edilmek
uzere gonderilir.

= Sonrasinda veritabanindaki kayitlarin guncel listesini DataGridView'da gostermek igin listele()
metodu cagrilir.

€



Veritabanindan Silme

= SiL Butonu Komutlari:

private void buttonl_Click(object sender, EventArgs e) //SIL Butonu
{

tl = comboBoxl.Text; //Sec¢ilen satirin malzeme kodunu al. Bkz: dataGridViewl CellContentClick metodu
baglanti.Open();
SqlCommand komut = new SglCommand("DELETE From Malzemeler WHERE MalzemeKodu=('"+tl1l+"')", baglanti);
komut.ExecuteNonQuery();
baglanti.Close();

listele();
}

= DataGridView’a tiklandiktan sonra secilen satir SIL butonuna tiklanarak silinir.

« ONEMLI: Silme Islemi malzeme kodu baz alinarak yapilir. Ayni malzeme koduna sahip birden fazla
kayit varsa hepsi veritabanindan silinir.
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Veritabaninda Kayit Giincelleme

= Kayit guncelleme icin oncelikle guncellenecek olan kaydin secilmesi gerekmektedir. Bu islem
DataGridView’da tiklama yoluyla yapilabilir. DataGridView’'da bir hiucreye tiklandiginda, o satirin
tamamen secilebilmesi icin SelectionMode 6zelligi FullRowSelect olarak ayarlanmalidir.

o0 = | B | &3
Malzeme Kayit ABC Analizi Cikig
Malzeme Bilgileri
EKLE
Malzeme Kodu: Birim Fiyat (TL/Adet): |:|
SiL

Malzeme Ad: |:| Min Stok: |:|

Yillik Satis (Adet): |:| Tedarik Siiresi (Giin): |:| GUNCELLE
Cl ] L]
C ]
CF F (]

DataGridView’da Satirin Bir

Biitiin Olarak Sec¢ilmesi

Properties *[OX
dataGridView1 System.Windows.Forms.DataGridView

o= |24 9| £

RowHeadersBorderStyle Raised

RowHeadersDefaultCellStyle DataGridViewCellStyle { BackColor=Cal

RowHeadersVisible True

RowHeadersWidth 51

RowHeadersWidthSizeMode EnableResizing

RowsDefaultCellStyle DataGridViewCellStyle { }
RowTemplate DataGridViewRow { Index=-1}

ScrollBars Both
v
ShowCellErrors True
ShowCellToolTips True
ShowEditinglcon True
ShowRowErrars True

Size 795, 188
StandardTab False
Tablndex 27
TabStop True
Tag

Edit Columns.., Add Column...

SelectionMode
Indicates how the cells of the DataGridView can be selected.

®




Veritabaninda Kayit Giincelleme

= Ardindan, DataGridView’da tiklama yoluyla secilen bir satirin hticrelerindeki verinin comboBox ve

private void dataGridViewl CellContentClick(object sender, DataGridViewCellEventArgs e)

{

textBox'lara aktarilmasi asagidaki komutlarla yapilir.

comboBox1.Text = dataGridViewl.CurrentRow.Cells[@].Value.ToString();
.CurrentRow.Cells[1].
.CurrentRow.Cells[2].
.CurrentRow.Cells[3].
.CurrentRow.Cells[4].
.CurrentRow.Cells[5].

textBox2.Text
textBox3.Text
textBox4.Text
textBox5.Text
textBox6.Text

a5 Malzeme Kayit

Malzeme Kayit  ABC Analizi

Malzeme Bilgileri

Cikig

Malzeme Kodu: ’HMDUB

Malzeme Adi: Malzeme 3
Yililk Satis (Adet): 25000

W

dataGridViewl
dataGridViewl
dataGridViewl
dataGridViewl
dataGridViewl

- O X

EKLE

Birim Fiyat (TL/Adet): | 40 |

Min Stok:

300 SiL

Tedarik Siiresi (Giin):| 4 GUNCELLE

MalzemeKodu
HMO01
» HMO08
MM450

MalzemeAdi
Malzeme1
Malzeme 3

Malzeme 32

Yillik Satis
10000
25000
600

BirmFiyat
60
40
1200

MinStok TSuresi
200 3
300 4
30 12

Value
Value
Value
Value
Value

.ToString();
.ToString();
.ToString();
.ToString();
.ToString();

« ONEMLI: Kodlar DataGridView’in Click olayina

yazllir.
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Veritabaninda Kayit Giincelleme

private void btnGuncelle Click(object sender, EventArgs e) // GUNCELLE Butonu

{
tl = comboBoxl.Text;
t2 = textBox2.Text;
t3 = textBox3.Text;
t4 = textBox4.Text;
t5 = textBox5.Text;
t6 = textBox6.Text;
baglanti.Open();
SglCommand komut = new SglCommand("UPDATE Malzemeler SET MalzemeKodu="" + tl1 + "', MalzemeAdi="" + t2 + "', " +
"YillikSatis="" + t3 + "', BirimFiyat="" + t4 + "', MinStok="" + t5 + "', Tsuresi="" + t6 + "' " +
"WHERE MalzemeKodu='" + t1 + "' ", baglanti);
komut.ExecuteNonQuery(); B akEmc ke - B
baglant i Close ( } ; Malzeme Kayit ~ ABC Analizi  Gikig
listele(); Malzeme Bilgileri
EKLE
1 Malzeme Kodu:  |HM003 |  Birim Fiyat (TL/Adet): .
Malzeme Adi: @ Min Stok: e
Yilik Satis (Adet): [E\ Tedarik Siiresi (Gin): |T| | GUNCELLE |
MalzemeKodu MalzemeAdi Yillik Satis BirimFiyat MinStok TSuresi
2 HMO01 Malzeme1 10000 60 200 3
'HM008 lMaIzeme 3 »25000 40 ‘300 4
‘ST047 .Celik XXX '14000 25 ‘500 9
‘MM450 .MalzemeS »15000 12 ‘230 5
l HMO00S Malzeme 45 25000 40 300 40




Veritabaninda Kayit Giincelleme

private void btnGuncelle Click(object sender, EventArgs e) // GUNCELLE Butonu

{
tl = comboBoxl.Text;
t2 = textBox2.Text;
t3 = textBox3.Text;
t4 = textBox4.Text;
t5 = textBox5.Text;
t6 = textBox6.Text;
baglanti.Open();
SglCommand komut = new SglCommand("UPDATE Malzemeler SET MalzemeKodu="" + tl1 + "', MalzemeAdi="" + t2 + "', " +
"YillikSatis="" + t3 + "', BirimFiyat="" + t4 + "', MinStok="" + t5 + "', Tsuresi="" + t6 + "' " +
"WHERE MalzemeKodu='" + t1 + "' ", baglanti);
komut.ExecuteNonQuery(); . Malzme K2 - B
baglanti,Close(}; Malzeme Kayit ~ ABC Analizi  Gikig
listele(); Malzeme Bilgileri
EKLE
} Malzeme Kodu: ["HMOOQ vi Birim Fiyat (TL/Adet): | 40 ‘
. ) ) . o Malzeme Adi: W Min Stok: 300 =
= Bu komut ile, secilen bir satirdaki degefler yukari e Zooos | Todark Sires G| 50|
aktarildiktan sonra degisiklik yapilip GUNCELLE butonuna
= H H MalzemeKodu MalzemeAdi Yillik Satis Birim Fiyat MinStok TSuresi
tiklanir. MalzemeKodu degeri baz alinarak veritabaninda e T T e
deg|§|k||k yap|||r_ | HMoog | Malzeme 3 25000 40 300 4
‘ ST047 .Celik XXX 14000 25 500 S
‘ MM450 Malzeme 9 15000 12 230 5
HM00S Malzeme 45 25000 40 300 40




Form2-Pareto Analizi

Dla File Edit View | Project | Build Debug Test Analyze Tools Extens
Q- B W 13 Add Windows Form..

'D Add User Control (Windows Forms)...
Toolbox ¥ £3 Add Component...

Search Toolbox *%  Add Class..

= Simdi projemize ABC Analizi yapacak bir form ekleyelim.
Yeni formumuzu Project-> Add Windows Form yolunu

izleyerek ekleyebiliriz.

=
o
—
=1
LA
o]
| =
=
[m]
&

4 General *@ Add New Data Source...

There are no usat & Add New Item.. Ctrl+Shift+A

= Formlar arasinda gecis yapmak icin de Menu yapisi
kullanilabilir. Bu amacgla MenuStrip kullanilarak
formumuzda ust menu olusturulabilir.

o5 Malzeme Kayit

Malzeme Kayit | ABC Anahizi  Cikis

(L) =] Fllwy ] § | LJIIHII'EI ]

= Olusturulan menustrip elemanlarina alt elemanlar eklenebilir
ve formlar arasinda gecis yapmak i¢in her birinin Click
olayina komutlar yazilabilir.




Formlar Arasinda Gecgis

= Form1’de Ust mentiden ABC Analizi sekmesine tiklaninca Form2 gosterilecektir. Bu amagla
kullanilabilecek kodlar asagidadir.

private void Menultem2 Click(object sender, EventArgs e)

{
Form2 ABC = new Form2();
ABC.Show();
.Hide();
}

= Ayni menu yapisi Form2’'de de olusturulur. Bu defa da Malzeme Kayit sekmesine tiklaninca
asagidaki kodlar yardimiyla Form1 g0sterilecektir.

private void MenuIteml Click(object sender, EventArgs e)

{ [stenmeyen menii elemanlarinin
Forml MalzemeKayit = new Forml();
.Hide();
}

€



- Form2’nin tasarimi yandadir. Bu formda

Malzeme Kayit ~ABC Analizi  Cikis

ABC analizi yapilmak istenen malzemeler
Veritabanindan Getirilebilir.

Veritabamindan Getir TEMIZLE

= Ayrica manuel dizenlemeye de izin
verilmektedir. Bunun icin once
veritabanindan veriler getirilmeli, ardindan
TEMIZLE butonuna basiimalidir.

o5l ABC Analizi — O X

Malzeme Kayit ~ ABC Analizi Gikig

MalzemeKodu MalzemeAdi Yillik Satis Birim Fiyat Min Stok TSuresi

Yukaridaki tabloya verileri girdikten sonra butona basiniz:

Yukandaki tabloya verileri girdikien sonra butona basiniz: I:|




SqlConnection baglanti = new SglConnection("Data Source=LENOVO-IKUCUKKO;Initial Catalog=ABC;Integrated Security=True");
SglDataAdapter da;
DataTable tablo;
public void listele()
{
baglanti.Open();
da = new SqlDataAdapter(“"select *FROM Malzemeler", baglanti);
tablo = new DataTable();
da.Fill(tablo);
dataGridViewl.DataSource = tablo;
baglanti.Close();

private void Form2_ Load(object sender, EventArgs e)
{
MenuIteml.Enabled
MenuItem2.Enabled

true;
false;

}

private void Menulteml_Click(object sender, EventArgs e)

{

Forml MalzemeKayit = new Forml();
MalzemeKayit.Show();
this.Hide();




private void button2 Click(object sender, EventArgs e) //ABC Analizi Yap Butonu

{
int n = dataGridViewl.Rows.Count-1;
[,] dizil = new [n, 37;

for (int 1 = @; i < n; i++)

{
dizil[i,@] = dataGridViewl.Rows[i].Cells[@].Value.ToString();//MalzemeKodu
dizil[i,1] = dataGridViewl.Rows[i].Cells[2].Value.ToString();//YillikSatis
dizil[i,2] = dataGridViewl.Rows[i].Cells[3].Value.ToString();//BirimFiyat

}

Form3 ABC = new Form3(dizil);
ABC.Show();
//this.Hide();




private void Menultem3 Click(object sender, EventArgs e)//Cikis Meni

{
Application.Exit();
¥
private void buttonl_Click(object sender, EventArgs e)//TEMIZLE Butonu
{
tablo.Rows.Clear();
dataGridViewl.Refresh();
¥
private void btnVt_Click(object sender, EventArgs e) //Veritabanindan Getir
{
listele();
¥

private void Form2_FormClosing(object sender, FormClosingEventArgs e)

{
Application.Exit();

}




Form3 - Sonu¢ Ekrani

1

Girilen Veriye Gore Hesaplanan Yiizdeleri Gosteren Sirah Liste

A Grubu

listBox1

B Grubu

listBox2

C Grubu

listBox3

B

labell label2 label3

= Sonuglarin gosterilmesi yeni bir
form Uzerinden yapilacaktir. Bir
onceki formda ABC Analizi Yap
butonuna basilmasi ile Form3
gOsterilir.

= Ayrica Form3’te kullaniimak
uzere, ABC Analizi yapilacak
malzeme bilgileri de dizil ismiyle
Form3’e gonderilmektedir.




o) Form3 = a X

= ABC Analizi hesaplamalari Form3’ln

Load olayina yazilmistir. Girilen Veriye Gore Hesaplanan Yiizdeleri Gosteren Sirall Liste A;';’;’:ss
Malzeme - Kimulatif
= Form3 yiiklenirken ks oo Bl i Yo
. . . . . > 12000000 79 79
malzemelerinYillikSatis ve BirimFiyat HMO0S 1000000 07 % —
= : HMO009 1000000 07 93 HMO08
degerler! carpilarak Toplam Satis D oo w . fooes
deg@erleri hesaplanir. Malzemeler ST047 350000 2 )
Toplam Satis degerine gore azalan — e — : C Grubu
sekilde siralanir. Yuzde ve Kimulatif STOA7
. o . MM450
Yuzde degerleri hesaplanarak %80 ve
%95 degerlerinden A, Bve C
gruplarina ayrilirlar.
1 21 3 N




string[,] veri,
public Form3(string[,] dizil)

{
veri = dizil;
InitializeComponent();
}
private void Form3 Load(object sender, EventArgs e)
{

int n = veri.GetLength(0);

string[] malzeme = new string[n];
double[] toplamSatis = new double[n];
double toplam = ©;

for (int 1 = @; 1 < n; i++)

{
malzeme[1i] = veri[i, 0];
toplamSatis[i] = Convert.ToDouble(veri[i, 1]) * Convert.ToDouble(veri[i, 2]);
toplam += toplamSatis[i];




//Selection Sort (Blyilkten Kiicige Siralama)
double yedekl;
string yedek2;
int maxIndex;
//double enb = -1;
for (int i = 0; 1 < n-1; i++)
{
maxIndex = 1i;
for (int j = 1; j < n; j++)

: if (toplamSatis[j] > toplamSatis[maxIndex])
{
maxIndex = j;
}
}

yedekl = toplamSatis[i];
toplamSatis[i] = toplamSatis[maxIndex];
toplamSatis[maxIndex] = yedekl;

yedek2 = malzeme[i];
malzeme[i] = malzeme[maxIndex];
malzeme[maxIndex] = yedek2;




//DataGridView'da sirali listeyi goster
dataGridViewl.ColumnCount = 4;
dataGridviewl.Columns[@].Name = "Malzeme Kodu";
dataGridViewl.Columns[1].Name = "Toplam Satis";
dataGridViewl.Columns[2].Name = "Yizde";
dataGridViewl.Columns[3].Name = "Kumilatif Yuzde";

double[] yuzde = new double[n];
double[] kum = new double[n];//kimulatif yizde

//ylizdelerin hesaplanmasi

double baslangic = @;

for (int 1 = ©; 1 < n; i++)

{
yuzde[i] = toplamSatis[i]/toplam;
kum[i] = yuzde[i] + baslangic;
baslangic = kum[i];
if (kum[i] <= ©.80)
{

listBox1l.Items.Add(malzeme[1]);

} else if (kum[i] <= ©.95)

{

listBox2.Items.Add(malzeme[i]);
} else
{

listBox3.Items.Add(malzeme[i]);
}




//dataGridViewl'de goster
for (int 1 = 0; 1 < n; i++)

{

dataGridViewl.Rows.Add(malzeme[1], toplamSatis[i].ToString(), yuzde[i].ToString("#.##"),

kum[i].ToString("#.##"));
¥

//grafikte goster

labell.Text = listBoxl.Items.Count.ToString();
label2.Text = listBox2.Items.Count.ToString();
label3.Text = listBox3.Items.Count.ToString();

double levell = 9;
double level2 = ©;
for (int 1 = 9; 1 < n; i++)

{
if (kum[i] > levell && kum[i]<=0.8)
{
levell = kum[i];
} else if (kum[i] > level2 && kum[i] <= ©.95)
{
level2 = kum[i];
}
)

labeld.Text
labelS.Text
label6.Text

levell.ToString("#.##");
level2.ToString("#.##");
100.ToString("#.##");
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